
 

Customer Release Notes

Fiery Network Controller for DocuColor 3535, 
version 1.1

    

READ THIS FIRST

                                   
This document contains information about the Fiery Network Controller for 
DocuColor 3535™ software version 1.1. For detailed information on new features 
and software modifications in this release, see the Fiery Network Controller for 
DocuColor 3535 Customer User Addendum for detailed updates. 

Before using the Fiery Network Controller for DocuColor 3535 with version 1.1, 
make copies of the Customer Release Notes and the Customer User Addendum, and 
distribute them to all users.

NOTE: This document uses the term “Fiery” to refer to the Fiery Network Controller 
for DocuColor 3535. 

Before printing to the Fiery®:

• Make sure system software version 1.1 is installed on the Fiery.

• Install user software onto client computers. For instructions, see the
User Software Installation Guide.

NOTE: For proper removal of the Fiery printer drivers, use the Fiery Printer Delete Utility. 
For more information, see the User Software Installation Guide. To remove all other 
software, see the documentation that came with your operating system.

Software modifications

DocuColor 3535 Network Controller version 1.1 software includes modifications for the 
following issue. For detailed information, see the Fiery Network Controller for DocuColor 
3535 Customer User Addendum for version 1.1.

• Windows printing is enabled by default

• Two (2) User Software CDs included in the Media Pack

• Detailed information on scan workflow

• Detailed information on Black Detection

New features/functions

DocuColor 3535 Network Controller version 1.1 software includes new features for the 
following issues. For information on Imageable Area sizes, see page 2. For information on 
SNMP Setup, see page 4. For information on all other new features in the following list, 
see the Fiery Network Controller for DocuColor 3535 Customer User Addendum for 
version 1.1. 

• Mailbox/Job Template Utility for scan workflow
• New print options or modifications to print options
• Additional Output Profiles and Calibration Sets
• PCL Driver and PPD support for all Windows operating systems
• Fiery Remote Installer
• Support for Nordic languages (Danish, Finnish, Norwegian, and Swedish) for  PostScript 

and PCL. 
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Increase in imageable area

This feature increases the imageable area for all paper sizes. The expanded imageable area 
is automatically available when you select any of the paper sizes. You will notice a smaller 
margin on output compared to software version 1.0.

NOTE: Smaller imageable areas are attained for Microsoft Windows XP if Service Pack 1 
is not used.

This feature is available after you load the new printer files on your Windows and/or Mac 
operating system. You can use the Installer WebTool to download the printer files. 

For margins supported on all paper sizes, see the following tables for PostScript and PCL. 
Due to copier variation, margins are within +/- 0.5mm.

NOTE: PCL is in agreement with logical (HP Standard) pages.

PostScript page size Measured margins (mm)

Left Bottom Right Top

Letter/8.5x11 LEF 2.00 2.00 4.00 2.00

LetR/8.5x11 SEF 2.00 2.00 4.00 4.00

A4/A4 LEF 2.00 4.00 4.00 2.00

A4R/A4 SEF 2.00 2.00 3.00 4.00

A3/A3 SEF 2.00 2.00 3.00 4.00

B5/B5 LEF 2.00 2.00 4.00 2.00

B5R/B5 SEF 2.00 2.00 3.00 4.00

B4R/B4 SEF 2.00 2.00 2.00 5.00

A5/A5 LEF 2.00 2.00 4.00 4.00

A5R/A5 SEF 4.00 2.00 2.00 4.00

8x10/8x10 LEF 2.00 2.00 4.00 3.00

8x10R/8x10 SEF 2.00 2.00 3.00 4.00

Tabloid/11x17 SEF 3.00 2.00 3.00 4.00

TabloidExtra/12x18 SEF 2.00 2.00 0.90 5.00

Legal 13/8.5x13 SEF 2.00 2.00 3.00 4.00

Legal/8.5x14 SEF 2.00 2.00 2.00 4.00

Statement/5.5x8.5 LEF 2.00 2.00 4.00 4.00

StatementR/5.5x8.5 SEF 2.00 2.00 2.00 4.00

SEFSRA3/SRA3 SEF 8.50 2.00 8.50 4.00
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PCL page size Logical (HP Standard) (mm)

Left Bottom Right Top

letter.port 6.25 6.25 4.17 4.17

letter.land 5.00 5.00 4.17 4.17

letR.port 6.25 6.25 4.17 4.17

letR.land 5.00 5.00 4.17 4.17

A4.port 5.92 5.92 4.17 4.17

A4.land 4.92 4.92 4.17 4.17

A4R.port 5.92 5.92 4.17 4.17

A4R.land 4.92 4.92 4.17 4.17

A3.port 5.92 5.92 4.17 4.17

A3.land 4.92 4.92 4.17 4.17

B5.port 5.92 5.92 4.17 4.17

B5.land 4.92 4.92 4.17 4.17

B5R.port 5.92 5.92 4.17 4.17

B5R.land 4.92 4.92 4.17 4.17

B4R.port 5.92 5.92 4.17 4.17

B4R.land 4.92 4.92 4.17 4.17

A5.port 5.92 5.92 4.17 4.17

A5.land 4.92 4.92 4.17 4.17

A5R.port 5.92 5.92 4.17 4.17

A5R.land 4.92 4.92 4.17 4.17

8x10.port 6.25 6.25 4.17 4.17

8x10.land 5.00 5.00 4.17 4.17

8x10R port 6.25 6.25 4.17 4.17

8x10R.land 5.00 5.00 4.17 4.17

Tabloid.port 6.25 6.25 4.17 4.17

Tabloid.land 5.00 5.00 4.17 4.17

TabloidExtra.port 6.25 6.25 4.17 4.17

TabloidExtra.land 5.00 5.00 4.17 4.17

Legal13.port 6.25 6.25 4.17 4.17

Legal13.land 5.00 5.00 4.17 4.17

Legal.port 6.25 6.25 4.17 4.17

Legal.land 5.00 5.00 4.17 4.17

StatementG.port 6.25 6.25 4.17 4.17
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SNMP Setup

The Fiery supports SNMP (Simple Network Management Protocol), which manages 
complex networks. For a list of SNMP limitations, see “SNMP limitations” on page 15.

TO ACCESS SNMP SETUP

1. Start your Internet browser. 

2. Enter the IP address or DNS name of the Fiery.

For this information, contact the operator or administrator.

3. Log onto the Fiery.

4. When the Fiery home page appears, click More Setup, and then click the SNMP tab.

5. Select Enabled.

This option enables the SNMP communication over a TCP/IP or IPX connection. If you 
do not select Enable, this disables any access to remote Setup through Fiery WebSetup and 
Command WorkStation.

NOTE: You can choose to disable SNMP, but there are SNMP limitations. Before you 
choose to disable SNMP, see “SNMP limitations” on page 15.

Left Bottom Right Top

StatementG.land 5.00 5.00 4.17 4.17

StatementR.port 6.25 6.25 4.17 4.17

StatementR.land 5.00 5.00 4.17 4.17

SRA3.port 5.92 5.92 4.17 4.17

SRA3.land 4.92 4.92 4.17 4.17

PCL page size Logical (HP Standard) (mm)
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6. Enter an SNMP Community Name.

This option allows you to change the SNMP Community Name (“public” by default) 
for read-and-write access. Enter up to 32 ASCII characters, including spaces, for the 
community name.

NOTE: If you change the community name or disable SNMP, WebSetup or the Fiery Auto 
Search will not work. Turn the DocuColor 3535 off, then on again, any time you make a 
change to the More Setup SNMP tab. 

7. Click Save.

NOTE: To change settings in the SNMP tab, enter "Admin" as the User Name and the 
Administrator password in Command WorkStation as the Password.

Software updates

DocuColor 3535 Network Controller version 1.1 software includes software updates for 
the following:

• Update file 1-8MEKD.ps

• Update file 1-8U29F.ps

• Update file 1-8T0ZZ.ps

• Update file 1-A055V.ps

• Custom PPD provided for QuarkXPress

• Auto Clear Server

Further detail on these software updates follows.

Update file 1-8MEKD.ps

This software patch fixes the following issues:

• 1-8KHW5—004-314 Fault, System crashes with Collate set to Off on Mac OS X.

• 1-8IYHP—004-371 Fault, Kernel Panic occurs when you restart printing after you 
empty the output tray.

• 1-8LEZT—004-341 Fault, System crashes with Collate set to Off on Mac OS X.

Update file 1-8U29F.ps

This software patch fixes the following issues:

• 1-8T4P1—When you cancel a print job because there is no paper in the Bypass Tray, the 
Fiery does not respond. 

• 1-8S3QH—017-310 Unknown Fault Code, When you cancel a pending job with 
Command WorkStation while you are copying a large job you will receive a fault 
message. 

Update file 1-8T0ZZ.ps

This software patch fixes the following issue:

• 016-387, Fault
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Update file 1-AO55V.ps

This software patch fixes the following issue:

• 1-A25U5—Printing a QuarkXPress document causes the printer to issue an 
error message.

Custom PPD provided for QuarkXPress

The QuarkXPress Custom PPD fixes the following issues:

• 1-95T3L—When you print from QuarkXPress 5.0 SEF 11x17 (or any other paper size) 
and the duplex option is selected, the job is not printed duplex.

• 1-9K65H—Mac driver does not accept job changes.

• 1-9K7XD—11x17 Landscape does not duplex.

• 1-9JZAM—Cannot print to finisher from QuarkXPress.

• 1-9C5EQ—Cannot print to SRA3 paper.

All issues listed above apply only to QuarkXPress versions 4.x and 5.0. The upgrade to 
QuarkXPress 5.01 contains a fix for all these issues. QuarkXPress v5.01 can be used 
successfully with the PPD supplied on the User Software CD for the Fiery Network 
Controller for DocuColor 3535, version 1.0.

Use the Custom PPD provided for QuarkXPress with QuarkXPress 4.x and 5.0 only. Other 
applications on the same Mac OS computer should use the PPD on the User Software CD.

The updated PPD from this release does not allow the use of Custom Paper sizes in 
QuarkXPress 4.x or 5.0. To use Custom Paper sizes with QuarkXPress 4.x or 5.0, you 
must use the PPD on the User Software CD. The following procedure for instructing 
QuarkXPress to use the revised PPD enclosed with this release can also be used for 
instructing QuarkXPress to use the supplied PPD from the User Software CD.

TO INSTALL THE REVISED PPD FOR QUARKXPRESS

1. On a clean Mac OS 9 system, run the Mac OS 9 English AdobePS 8.7.2 Installer from the 
User Software CD.

2. Restart the computer.

3. Create a Desktop Printer through the usual process in the Chooser.

4. Copy the PPD file “Xerox DocuColor3535 Quark PS” (included in this release) to 
System Folder:Extensions:Printer Descriptions.

There are now two PPDs in this location: “Xerox DocuColor3535 PS” and “Xerox 
DocuColor3535 Quark PS.”

5. Double-click the Desktop Printer that you just installed.

6. Choose Printing > Change Setup.

7. Change the PPD file to “Xerox DocuColor3535 Quark PS” and click OK.

8. Open a QuarkXPress file.
Part Number: 45033611



 

Page 7

           
9. Choose Utilities > PPD Manager.

10. Click Select and browse to System Folder:Extensions:Printer Descriptions.

11. Click Update.

12. Choose File>Print.

13. In the Setup Tab, make sure that “Xerox DocuColor3535 Quark PS” is selected as the PPD.

14. Click Printer >Printer Specific Options.

15. Change settings to Duplex Option (Top-Top, Top-Bottom).

16. Click Print.

Settings are applied and output is correct.

Issues fixed in this release

The following issues have been fixed in this release:

• B5 paper size

• Copies of FreeForm™ jobs do not display

• Template Description in Mailbox Setup

• QuarkXPress Separations do not work properly when you apply a tint

• CorelDRAW 9.0 cannot print properly on 11x17

• Copy Count in the printer driver

• Tray Alignment set for QuarkXPress jobs

• Process Black has yellow tint

• Landscape duplex jobs in QuarkXPress

• SRA3 size jobs from QuarkXPress

• Duplex printing with SEF paper sizes

• Jobs do not print with specified print options

• Top-Bottom duplex job does not print properly with FreeForm

• You cannot print separations with spot colors in PageMaker or QuarkXPress

• Gradient is not smooth when printing a duplex job

• Media types missing from Command WorkStation and the printer driver

• All pages are printed out in black when printing separations in QuarkXPress

• Errors received when accessing printer driver properties

• Restoring Fiery Server Software

Detailed descriptions of these issues follow.

B5 paper size

To print a job on B5 paper, select Tray 5 (Bypass Tray). Although this is a standard page 
size, it cannot be printed from the other trays. This issue has been fixed, and you can print 
a job on B5 paper size from other trays.
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Counting copies of FreeForm jobs

The FreeForm tab does not display the number of copies in a FreeForm job. After the job 
has been printed, see the Job Log. This issue has been fixed, and the FreeForm tab displays 
the number of copies in a FreeForm job.

Template Description in Mailbox Setup

When you select a template or destination mailbox, the Template Description button on 
the copier is not supported. It does not allow you to enter information about the template 
or mailbox. This issue has been fixed; the Template Description button on the copier 
is supported.

QuarkXPress Separations

When you submit a QuarkXPress job to print as separations with a PANTONE color that 
is 10% tint, the separations print solid, not tinted. This issue has been fixed, and if 
indicated, the separations print as tints.

When you submit a job with a native designed QuarkXPress element, the plates will not 
separate with the proper densities. This issue has been fixed, and the plates separate with the 
proper densities.

CorelDRAW 9.0 cannot print properly on 11x17

If you are printing a job on 11x17 size paper using CorelDRAW 9.0, the job will not print 
properly. This issue has been fixed, and CorelDRAW 9.0 prints 11x17 jobs properly.

Copy Count in the printer driver

When you set the copy count in the Print Properties window, it will not reflect in the Fiery 
printer driver. This issue has been fixed, and the copy count in the Print Properties window 
should reflect the copy count in the Fiery printer driver.

Tray Alignment set for QuarkXPress jobs

If Tray Alignment is set for an 11x17 QuarkXPress job, the tray will not center the job 
correctly. This issue has been fixed, and the tray aligns correctly.

Process black has yellow tint

“Process black” or “registration black” has a yellow tint and appears on jobs and test prints 
from the Fiery. This issue has been fixed, and process black does not have a yellow tint.

Landscape duplex jobs in QuarkXPress

You cannot print duplex landscape documents from QuarkXPress. This issue was fixed with 
the QuarkXPress Custom PPD, and you are able to duplex landscape jobs from 
QuarkXPress.

SRA3 size jobs from QuarkXPress

When you print from QuarkXPress 5.0 or 4.11 on SRA3 paper size, the job may jam 
because QuarkXPress does not center the document correctly and places it too close to the 
edge of the SRA3 sheet. This issue was fixed with the QuarkXPress Custom PPD and you 
are able to print on SRA3 paper size.
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Duplex printing with SEF paper sizes

Printing duplex pages with SEF paper sizes from QuarkXPress 5.0 is not supported. This 
issue was fixed with the QuarkXPress Custom PPD and you are able to print duplex pages 
with SEF paper sizes. 

Jobs do not print with specified print options

Jobs will not print with specified print options when printing from QuarkXPress on 
Mac OS 9 computers. To avoid this, use the LaserWriter 8.3.4 printer driver. This issue was 
fixed with the QuarkXPress Custom PPD and you are able to print with specified options 
on Mac OS 9 computers.

Jobs do not print to the Finisher

Jobs do not print to the Finisher from QuarkXPress. This issue was fixed with the 
QuarkXPress Custom PPD, and jobs print to the Finisher.

Top-Bottom duplex does not print properly with FreeForm

When you print top to bottom duplex, the second side of the job gets clipped. This issue 
was fixed and if you print top to bottom duplex, the job prints properly.

Spot colors in PageMaker and QuarkXPress

When you print separations with spot colors in PageMaker on Windows or Mac OS, you 
will receive an error message. This also occurs on QuarkXPress on Mac OS 9. This issue was 
fixed and separations with spot colors print correctly.

Gradient is not smooth when printing a duplex job

When you print a duplex job, on the second side of the paper, the gradient does not appear 
smooth. This issue was fixed and the gradient appears smooth.

Separations in QuarkXPress

If you try to print a QuarkXPress file using separations, each page is printed in pure black. 
This issue was fixed, and the separations print correctly.

Errors received when accessing the printer driver properties

You may receive errors when you access the printer driver properties on Windows NT 4.0. 
This issue was fixed, and you can access the printer driver properties without any errors.

Media types missing from Command WorkStation and the printer driver

Not all media types are listed in the printer driver and Command WorkStation. This issue 
was fixed and all media types are shown in the printer driver and Command WorkStation.

Restoring Fiery server software

Use the following procedure to restore the server software portion of the system software. 
Use this procedure only if you are experiencing problems with the Fiery and have been 
advised by your service/support representative to restore the server software. 

There have not been any changes to the Utilities associated with the DocuColor 3535 
Network Controller version 1.1 update. Reload your DocuColor 3535 Network Controller 
software and print drivers.
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The following utilities have not been changed:

• Command WorkStation (version 4.0.21)

• Fiery Remote Scan (version 5.2.0.7)

• Fiery Printer Delete Utility (version 1.05)

• Fiery Downloader™ (version 3.2.039 PC and version 3.2.040 for Mac OS)

• ColorWise Pro Tools™ (version 3.2.8)

• EFI Fiery Mail Port (version 1.0.012)

• Fiery Spooler™ for Mac only (version 4.6.18)

The following parts of the system are affected by the reinstallation of server software:

• JOB LOG—Restoring server software deletes the list of jobs in the Job Log and any jobs in 
the queues. Use Command WorkStation to save a current list of jobs (not the actual jobs) 
from the Job Log (see the Job Management Guide).

• FONTS—Restoring server software deletes all additional fonts installed on the Fiery. 
Resident fonts are restored during server software restoration. 

To determine the additional fonts that were downloaded to the Fiery, print the font list 
before you restore server software and again after you complete the server software 
restoration. You must reinstall any fonts not listed after restoration.

• CUSTOM SIMULATION AND OUTPUT PROFILES—Custom simulation and custom output 
profiles saved on the Fiery are deleted when you restore server software. Save a copy 
of any custom profiles before you install software. For more information, see the 
Color Guide.

• SCANS—Save all scan templates. For more information, see the Customer User Addendum.

NOTE: This procedure does not reinstall the operating system portion of the 
system software.

TO RESTORE THE SERVER SOFTWARE PORTION OF THE SYSTEM SOFTWARE

1. Print the Configuration page to record the current Setup configuration. 

Settings revert to the factory configuration when server software is restored.

2. Print the Font List.

For instructions on printing the Font List, see the Printing Guide.

3. Insert the System Software CD into a Windows computer that can print to the Fiery and 
has Command WorkStation installed.

4. Start Command WorkStation and connect to the Fiery.

If you have problems, make sure Setup is configured properly.

5. Choose Import from the File menu, and then choose Job.

6. Navigate to the location of the System Software CD and select the DC3535_x_x.ps file, 
where the “x_x” represents the version number.

For example, the name of the version 1.1 file is DC3535_1_1.ps.
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7. Click Add.

8. Choose either the Print queue or the Direct connection from the Logical Printer menu.

If you are unable to choose the Print queue or Direct connection, make sure the connection 
is enabled in Setup. (To enable the Print queue or Direct connection, see “Printer Setup 
Options” in the Configuration Guide.)

9. Click Import.

Allow several minutes for the file to download. After the file is downloaded successfully, the 
Fiery prints a confirmation page. 

NOTE: You can also download files using Fiery Downloader or Fiery WebDownloader. 
For more information about downloading files using these utilities, see the Printing Guide.

10. Turn off the copier using the main power switch on the front. Wait 5 seconds, and then 
turn on the copier. 

Allow the copier to start up and display the Ready status on the Touch Screen. Do not press 
any buttons while the copier is starting up.

11. Wait until the Start Page is printed from the copier.

If the Start Page has not been printed, turn off the power and turn it on again. Allow the 
Start Page to be printed.

12. Remove the CD from the Windows computer. 

13. Configure Setup on the Fiery using the Configuration page that you printed earlier.

14. Print a new Configuration page and verify that the version number in the Server Info 
section matches the version number of the file that you downloaded.

15. Reinstall fonts or custom profiles.

TO UPGRADE THE PRINTER DRIVER SOFTWARE

1. Remove the current printer driver using the Fiery Delete Utility.

For more information about using the Fiery Delete Utility, see the User Software Installation 
Guide that came with your DocuColor 3535 Network Controller version 1.0.

2. Start your Internet or intranet browser and enter the DNS name or IP address of the Fiery.

3. Click Installer on the WebTools home page.

4. Under the name of your operating system, click Printer Files.

A dialog box appears, prompting you to save the file to the location you choose.

For Windows computers, a dialog box appears, offering you the choice of running the 
program across the Internet or intranet or saving it to disk.

For Mac OS computers, a folder named Printer Driver is downloaded to the desktop in 
a BinHex-encoded, compressed format. If your Internet browser is equipped with an 
expander utility, such as StuffIt Expander, the folder decodes and decompresses 
automatically.

5. For Windows computers, browse to the location where you want to save the 
Prntdrve.exe file and click Save.
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For Mac OS computers, if the Printer Driver folder was not automatically decoded and 
decompressed, start the utility that performs that function.

For more information about installing printer drivers, see the User Software Installation 
Guide that came with your DocuColor 3535 Network Controller version 1.0.

Issues in this release

Server Setup

You cannot assign the server the same name as the device name (DC3535). Utilities may not 
function properly. 

Color files for Nordic languages

The following color files are not included for the Nordic languages (Norwegian, Finnish, 
Swedish, and Danish):

Win English Color Files

• CMYK.PS

• PANTONE.PS

• RGB_01.DOC

• RGB_02.PPT

• Custom21.ps

• Custom34.ps

• Stand21.ps

• Stand34.ps

 Mac English Color Files

• CMYK Color Reference.ps

• PANTONE Book.ps

• RGB page 01

• RGB page 02

• custom21.ps

• custom34.ps

• standard21.ps

• standard34.ps

Restarting the Fiery

After you receive a message to restart the Fiery (such as after calibrating or saving Setup 
changes), you must wait at least 60 seconds before turning off the copier.

Factory defaults for non-English systems

After you apply the Factory Defaults setting, the system reboots. However, the system 
language is English. To get the system to display the appropriate language, reboot again. 

When you choose Factory Defaults for systems in any language (even English), all stored 
jobs, calibration, logs, and network settings are deleted.

Setup

User Software CD

SetupSystem
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Maximum number of users for SMB

The Fiery supports a total of eight simultaneous SMB connections, including the 
Direct connection, Print queue, and Hold queue.

Windows 2000 and LPR availability

When you perform a clean installation of Windows 2000 on a client computer, no LPR 
services are available by default. Your only option is to print through a standard TCP/IP 
port or use SMB printing. However, if you converted a Windows NT 4.0 computer to 
Windows 2000, LPR printing services are retained.

Creating an SMB port in Windows 2000/XP

To create an SMB port in Windows 2000/XP, you must first establish a connection to the 
Fiery by its IP address. Choose Start and select Run. At the prompt, enter “\\” followed by 
the Fiery IP address, and then click OK. After you make the connection, follow the 
instructions to create an SMB port on Windows 2000/XP.

Banner Page on NetWare networks

We recommend that you disable the NetWare banner page. Instead, configure the Fiery in 
Setup to use the Cover Page with each job.

User name on Cover Page from Netware 

The Cover Page displays the complete NetWare context for the user name. 

Job status information

When you make photocopies on the copier, information about the job is displayed. The 
same kinds of information, however, are not displayed while the Fiery is printing a job. 
To determine information about a job sent to the Fiery, print the Job Log, or view the 
job with the job management tools (Command WorkStation, Fiery Spooler, or 
Fiery WebSpooler™).

Messages from the copier during shutdown

Depending on whether the copier is in Power Save mode or not, you see a different message 
when you turn off the copier. If the copier is in Power Save mode, the message is “Please 
wait...” If the copier is not in Power Save mode, the message is “Power off, Please wait while 
the machine is shutting down.” The two messages mean the same thing.

Name of paper sizes displayed on the copier

When you print a job on SRA3 paper, the copier displays the dimensions 17.7 x12.6" as 
the job is being printed, instead of the name “SRA3.” 

The page sizes 11x17" and 12 x19" are displayed by the copier with the dimensions 
in reverse; 17 x11" and 19 x12", respectively.
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Paper handling by the copier

Tray alignment is supported for Trays 1-4.

Fiery system pages (for example, the Job Log or Configuration page) are printed only to the 
Center Output Tray. The Cover Page, however, is printed to the same tray as the job that it 
is associated with.

When you select Auto for the tray, the copier takes paper from Tray 4. If Tray 4 is out 
of paper, the copier takes paper from the trays in the following order: Tray 3, Tray 2, and 
then Tray 1.

Clear Server

In Command Workstation, if you choose Clear Server from the Server menu, all jobs, 
including stored jobs, archived jobs, the e-mail log, and the job log, are deleted from the 
controller hard disk drive and memory.

After you perform Clear Server, the server software automatically reboots, and you must 
power cycle the copier (turn off and then turn on) using the power switch on the copier to 
resynchronize the copier with the Fiery. If you do not power cycle the copier, the Fiery is 
unable to print or scan.

On rare occasions, after you perform Clear Server, the copier displays the message “Switch 
the machine Off and then On. Fault #102-372.” If this occurs, wait at least 60 seconds, 
turn off the copier, and then turn it back on again. 

Date and time stamps for jobs

The date and time associated with a job are the date and time recorded by the Fiery, not the 
copier. The following table describes the date and time stamps recorded by the Fiery.

Date and time 
stamp location Description of date and time stamp

Error History Report Upper-right corner Date/Time: is recorded by the Fiery.
The Date field and Time field specified underneath is specified 
by the copier.

Font List The date described in the Generated: field header is recorded by 
the Fiery.

Job History Report Upper-right corner Date/Time: is recorded by the Fiery.
The Date field and Time field specified underneath is specified 
by the copier.

Job Log The date described in the Generated: field header is recorded by 
the Fiery.
The Date, Start Time, End Time, and Process Time fields are 
also recorded by the Fiery.

System Settings List Upper-right corner Date/Time: is recorded by the Fiery.
In the System Settings area, the mm/dd/yyyy field is recorded 
by the copier.

Configuration Page The date described in the Generated: field header is recorded by 
the Fiery.
Part Number: 45033611
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Changing the time in WebSetup

When you change the time and date using the IOT (Image Output Terminal) tools mode, 
the time stays the same in the header of reports such as the Job Log and Configuration 
Page. Change the time using Fiery WebSetup.

Member Printing

If Member Printing is enabled, you cannot download files from Fiery Downloader, 
WebDownloader, or Command WorkStation. If Member Printing is enabled, do one of the 
following:

• Print directly from the application in which the file was created.

• Download the file to the Hold queue, change the owner information for the job with 
Command WorkStation, and send the job to print.

After installing or upgrading software

After upgrading or reinstalling your software, if the Fiery does not reboot immediately, 
reboot again.

Start Page

After you install system software, you may notice that the first start page may not be 
completely translated in the specific language. Reboot the copier a second time and the start 
page is completely translated.

SNMP limitations

If you change the community name or disable SNMP, WebSetup does not work. Power off 
and on the device when you make a change to the SNMP tab in More Setup.

If you disable SNMP, the automatic search for the Fiery feature in Command WorkStation, 
which is based on SNMP, does not work.

If you disable SNMP, the following features are affected:

• Two-Way communication

• All Fiery applications that search for Fiery controllers using SNMP (Command 
WorkStation, Fiery Remote Scan, and Fiery Downloader)

• Xerox CenterWare

• Xerox MIBs

Login Window for SNMP

After you change and save the community name, a Login window appears. To validate the 
changes, enter “Admin” as the User Name and the Administrator password in Command 
WorkStation as the Password.

Disabling the queues

If you disable all the queues (Direct, Hold, Print) you cannot access the Fiery remotely. 
If you disable all the queues, WebSetup does not work, and you cannot reenable the queues. 
If this happens, reinstall the system software.
Part Number: 45033611
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Printer image

The printer image in the printer driver does not display properly if it is viewed in 24-bit 
screen resolution. To display the image properly, change the screen setting to 16-bit or 
32-bit resolution.

Member Printing and Saved Settings

In the Windows printer drivers, if you save a collection of settings that include Member 
Printing information (such as a printing group name and password), assign the Saved 
Settings a name. Do not leave the Saved Settings as “Untitled.”

PCL driver

Cover pages and separator pages do not print with the PCL driver. Use the PostScript driver 
to print cover pages and separator pages.

The Default button for Installable options in the Accessories tab does not work. Use the 
Add and Remove buttons to change Installable options.

When you browse for a Separator Page in the Windows 98/Me PCL driver, the Separator 
files (*.sep) do not appear. You must type *.* in order to browse for the separator files.

If you use a Separator Page and have a Finisher Tray installed, the job is sent to the Finisher 
tray, but the Separator Page is sent to the Center Tray.

If you enable a Cover Page from the Fiery, a Cover Page prints when you print from 
Windows 2000 via Appletalk with the PCL driver.

Novell Systems

If you print a job with Novell, the PCL Separator Page does not work

Printing color after wake-up

While the copier is in sleep mode, the fuser temperature may drop. After you take the 
DocuColor 3535 out of sleep mode to make it active, print out three or four pages in color, 
one at a time, to warm up the engine. During this time, the color output may appear 
to be inaccurate, because the fuser is still warming up. Once the fuser warms up, the 
DocuColor 3535 prints color correctly.

Collate

Do not use the Collate option within an application; use only the Collate option in the 
printer driver. However, for CorelDRAW and Microsoft Internet Explorer versions 5 and 
5.5, use the Collate option in the printer driver in addition to the Collate option within 
the application.

N-up printing

With QuarkXPress, CorelDRAW, and Adobe Photoshop, you may not get the correct 
number of n-up copies.

Printer driver

Printing

Print options
Part Number: 45033611
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Paper size

When you send a job from an application that allows you to specify paper size in the 
Print dialog box (such as Microsoft Word), select the same paper size in both the 
application’s Page Setup dialog box and the printer’s Properties dialog box.

Before printing your job, verify that the paper size selection in Document Setup and 
Page Setup are the same. This will resolve problems with the printed output, such as 
image clipping and unintentional scaling.

Supported paper sizes

The supported paper sizes are 8 x10 SEF, 8 x10 LEF, 8.5x11 LEF, 8.5x11 SEF, A4 LEF, 
A4 SEF, A3 SEF, B5 LEF, B5 SEF, B4 SEF, A5 LEF, A5 SEF, 11x17 SEF, 12 x18 SEF, 
8.5x13 SEF, 8.5x14 SEF, 5.5 x8.5 LEF, 5.5 x 8.5 SEF, SRA3 SEF, and PostScript Custom 
Page Size.

In the printer driver and Page Setup dialog box of Microsoft Office applications, select only 
these paper sizes.

Duplicate paper sizes

In the Windows NT 4.0, Windows 2000, and Windows XP printer drivers, there are 
duplicate paper sizes (LTR, Legal, Tabloid, A4, A3, and Statement). These duplicates occur 
in the list of paper sizes after the listing for “PostScript Custom Page Size.” Do not choose 
the duplicate sizes that occur after “PostScript Custom Page Size.”

Page Range

You cannot access the Page Range option from the printer driver. Use the application page 
range option or change the setting for this option from Command WorkStation, Fiery 
Spooler, or Fiery WebSpooler.

Custom Page Size

When you specify a custom page size in the printer driver for Windows 95/98, make sure 
the custom size matches the page size specified in your application. If the page sizes do not 
match, the custom page size may not print correctly.

NOTE: Custom Page sizes do not print with duplex jobs or if any of the Finishing options 
are set for the job.

Reverse order printing

Reverse order printing is not supported. 

Tray 5 (Bypass Tray)

If you print a job with Auto Select as the paper source, the copier uses any of the Trays 1- 4. 
This does not include Tray 5, which is the Bypass Tray.

Watermarks, Negative Image, and Print Page Borders

The Watermarks, Negative Image, and Print Page Borders features are not available in the 
Windows NT 4.0, Windows XP, or Windows 2000 PostScript and PCL printer drivers.

These features are located under Page Setup for Mac OS 9.1 and Mac OS X Classic mode.
Part Number: 45033611
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Mirror option

In Windows 9x printer drivers, selecting the Mirror check box updates the small icon to the 
left of the Orientation setting, but not the full-page icon in the lower-right corner of the 
printer driver. The printed result, however, is correct.

Entering IP addresses

In the printer Properties dialog box, pressing Enter after entering an IP address closes the 
dialog box. Press Tab or use the mouse to move between fields and fill in all options before 
you press Enter or click OK.

Cover Page does not display Notes or Instructions from Mac OS 9

The information that you enter in Notes and Instructions is not printed on the Cover Page. 

Screen Switching

If you set Screen Switching on, halftoned text may appear to have a different angle and 
frequency than the images and graphics within the job. To avoid this, set Screen Switching 
off before printing, to print all text, graphics, and images in a lower frequency screen.

Powerform Simulation

Even if you set the Powerform Simulation feature to On, it does not reduce the processing 
time for a PowerPoint print job.

SMTP services

You must enable SMTP services on your network’s e-mail server.

Member Printing

E-mail Printing is not supported with Member Printing enabled.

Supported file attachments

The supported file attachments for E-mail Printing are PostScript, PRN (Windows printer 
file), PDF (version 1.3), and TIFF (version 6).

E-mail account password

E-mail printing does not work if the Fiery e-mail account does not have a password. 
To receive e-mail print jobs, you must set a password for the e-mail account that the Fiery is 
configured to use.

JPEG and Microsoft Office Documents 

JPEG and Microsoft Office documents are not supported as printable attachments sent to 
the Fiery. 

Body text 

The body text of an e-mail sent to the Fiery is not printed; only supported attachments 
are printed. 

TIFF documents

When you send a TIFF document to the Fiery as an e-mail attachment, no cover page 
is printed.

E-mail Printing
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Downloading fonts

Before downloading fonts, clear the Member Printing option.

Job Size

Command WorkStation displays job size in kilobytes, regardless of the size of the file. 
Other tools may show job size in megabytes or kilobytes.

Job Log

With some odd-number duplex jobs that contain mixed page sizes, blank pages are counted 
as black-and-white printed pages.

Save and clear the Job Log regularly. After the Job Log accumulates a large number of 
entries (approximately 16,000 jobs), the Fiery stops responding when you start 
Command WorkStation.

Activity Monitor 

When you print more than one copy of a job, the Activity Monitor reports that Copy 2 is 
printing, and then Copy 2, Copy 3, Copy 4, and so on. Although the Activity Monitor 
does not start counting with Copy 1, the correct number of copies prints.

Imposed job cannot be saved if Hold queue is disabled

To use the imposition, preview, and rerouting features from Command WorkStation, you 
must enable the Hold queue.

Available memory

The General Info section displays the amount of memory available for 
Command WorkStation and other Fiery software, whereas the Configuration page displays 
the amount of memory available for Command WorkStation, other Fiery software, and the 
Fiery system software.

The “Memory 100%” displayed in the upper-right corner of the copier display is the copier 
memory. The memory bar in Command WorkStation is the Fiery memory.

Paper Tray Alignment

When you select Tray 3, Tray 4, Tray 3 (High Capacity), or Tray 4 (High Capacity) in the 
Paper Tray Alignment dialog box, 8.5 x11 LEF, A4 LEF, and B5 LEF are listed twice in 
the Media menu. Select any of the duplicate page sizes and the paper aligns correctly.

Combine Separations

If you send a job with Combine Separations set to On, you may see an error message in 
Command WorkStation. To avoid the error message, set Combine Separations to 
Printer’s default or Off, or send a Separations job.

Auto Clear Server

You must enable both Auto Print Job Log After 55 Jobs and Auto Clear Job Log After 
55 Jobs for them to function properly. Disabling either one of them results in both features 
not functioning. 

Selecting FreeForm masters at print time

You can create or use FreeForm masters numbered 1 through 10 in the printer driver. 
The Job Management Guide incorrectly states that masters 1-15 can be used.

Fonts

Command 
WorkStation

FreeForm
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License verification failed during job preview

If you attempt to preview a job and Command WorkStation displays a message that license 
verification fails, make sure the hardware installation key (or dongle) is installed. You cannot 
preview jobs unless the dongle is properly installed.

Color defaults

To set defaults for color printing options, use Color Setup in ColorWise Pro Tools. 
The exception is Color Mode, which cannot be set in Color Setup, nor in Setup from 
Command WorkStation or Fiery WebSetup. However, you can set the color mode for a job 
at print time when you print from the printer driver.

AutoCal and ColorCal 

Leave the Scan Resolution at 200 dpi. This is the only resolution supported. If you change 
the resolution, the message “Gray Scale is too far down (111)” may be displayed.

Make sure that the Original Orientation option on the copier is set to Head to Top and that 
the AutoCal™ and ColorCal™ patch pages are positioned Head to Top on the copier platen.

When you print measurement pages for AutoCal and ColorCal, an instruction page also 
prints. To ensure good results after calibration, follow these instructions.

Calibrating before Start Page is printed 

Allow the Start Page print before performing calibration. This ensures that the Fiery has 
fully completed its startup process.

Mac OS X Classic mode

The Fiery utilities such as Command WorkStation, Fiery Downloader, and Fiery Remote 
Scan are supported in Mac OS X Classic mode. However, the Fiery utilities are not 
supported in Mac OS X Native mode.

Drag and Drop

When you use the drag-and-drop method to print a file, Fiery Downloader functions 
slightly differently on the Mac OS than it does on Windows 95/98. On the Mac OS, 
when a file is dropped onto the Downloader icon, the Status window appears and remains 
displayed, even after the file is printed. On Windows, the Status window appears and then 
closes when the job finishes printing.

PDF files sent to the Direct connection are treated as if they were sent to the Print queue.

Adding files

In the Files to be Downloaded dialog box, you must either double-click the file or highlight 
the file and click Add Files. You cannot drop a file onto the Files to be Downloaded 
dialog box.

If an error occurs when adding a file to the download list, try the following:

• Make sure the file is closed. A file that is open for viewing cannot be added to the 
download list.

• If you are using Windows, start Windows Explorer and choose Folder Options from the 
View menu. Click the View tab and clear “Hide file extensions for known file types.”

DocBuilder Pro

ColorWise 
Pro Tools

Fiery utilities

Fiery Downloader
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File formats

Fiery Downloader supports only EPS, PDF (version 1.3), or PS formats for printing to 
the Fiery.

Downloading PDF files with mixed page sizes or orientations

When you download PDF files that contain more than one page size or orientation, the file 
may not print correctly. To print the file, open it in Adobe Acrobat and print using the 
printer driver.

Downloading EPS files

You must select Show EPS Files to download EPS files. 

Downloading 16-bit TIFF Files

Fiery Downloader is unable to download 16-bit TIFF files to the Fiery.

TWAIN acquire locks on mixed page size jobs

The Fiery Remote Scan TWAIN plug-in does not support transferring mixed original size 
scan jobs to applications such as Photoshop. However, the Fiery Remote Scan stand-alone 
application does support retrieving mixed scan jobs from mailboxes and distributing these 
jobs through e-mail or saving them to a local hard disk drive. 

Supported applications

The following applications support the TWAIN plug-in: Adobe Photoshop versions 5.5 
and 6.0 for Mac OS and Windows; and Adobe Acrobat versions 4.05 and 5.0 for Mac OS 
and Windows.

JPEG format

You cannot save black-and-white scanned documents as JPEG files.

Initiating a scan job

Initiating a scan job remotely is not supported. You can, however, retrieve and distribute 
scan jobs. To initiate a scan, you must use the Local User Interface on the copier. For more 
information on scanning workflow, see the Customer User Addendum.

Scanning or copying a job with the Local User Interface

When you scan or copy a document using the Local User Interface and choose Auto 
Enlarge or Variable, the image fails to enlarge correctly, and the bleed area decreases on the 
edges of the paper.

Custom Install for Brazilian Portugeuse

Custom Install for Fiery Remote Scan is in English for Brazilian Portugeuse.

Exiting WebTools 

Closing the window for an individual WebTool does not exit the browser. To exit WebTools 
completely, close the WebTools window and your browser.

Fiery Remote Scan

Fiery WebTools
Part Number: 45033611
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File types

When you browse files from WebDownloader, the default file name extension is “.html”. 
WebDownloader does not determine the default file type or the file type listed in the File 
dialog box. The default file type is predefined by your Internet browser. However, if you 
send html files to the printer, the data is printed as ASCII text (the default extension for 
ASCII text is .txt). Choose All Files from the Files of type menu to view other files 
to download.

PDF files sent to the Direct connection are treated as if they were sent to the Print queue.

When you download PDF files from a Windows computer, the file name and user name are 
displayed as “Unknown.”

You must select Show EPS Files to download EPS files.

Mac OS X

The Installer WebTool supports downloading only the Mac OS 9 printer driver and 
PPD (PostScript printer description). To install the PPD for Mac OS X, use the 
User Software CD.

JPEG format

You can save only color and grayscale images, not black-and-white, in JPEG format. You 
can, however save black-and-white images in either PDF or TIFF format. The same is true 
for JPEG images in Fiery Remote Scan.

Multiple-page TIFF documents

If you use WebScan™ to download a multiple-page document in TIFF format, you are able 
to view only the first page of the document in most image-editing applications. To view the 
entire document in the image-editing application, scan and download each page (and side, 
if duplex) of the document as a separate file. You can also use an application that supports 
viewing multiple-page TIFF documents.

TIFF documents

If an error occurs when you open a downloaded TIFF document in Photoshop, the 
document may have been downloaded with a .tiff extension in its file name. To open the 
document in Photoshop, first change the file extension to .tif.

Retrieving scanned jobs from copier Mailboxes/Job Templates

The three default Mailboxes/Job Templates are mapped to "0" by default and are accessed 
by WebScan and Fiery Remote Scan. The other two Mailboxes/Job Templates, AutoCal and 
ColorCal, are used for calibration only and are not mapped to “0”.

• 001 AutoCal

• 002 ColorCal

• 003 bw

• 004 color

• 005 grayscale

Fiery 
WebDownloader

Fiery WebInstaller

Fiery WebScan
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Access all other user-defined Mailboxes/Job Templates by selecting the Mailbox/Job 
Template name in WebScan or Fiery Remote Scan, not the number associated with the 
Mailbox/Job Template on the Local User Interface.

The Mailbox/Job Template name is case sensitive. You must use the exact name in Webscan 
or Fiery Remote Scan to upload your file.

Mailbox name or number same as Job Template

When you retrieve a scanned job with Fiery WebScan, the Mailbox name or number that 
you enter is the same as what the copier refers to as Job Template. These are two terms for 
the same item.

Cannot change Mailbox/Job Template Name in Edit Mode

When you select Edit mode for an existing Mailbox/Job Template on the copier, you 
cannot change the name of the Mailbox/Job Template, but you can change any of the 
Mailbox/Job Template settings, such as Color Mode or Scan Size.

Deleting files

To delete more than one file at a time, hold down the Ctrl key while you select the files.

JPEG files

When you save black-and-white scans as JPEG files, an error message appears. Save 
black-and-white files as TIFF files.

Accessing WebSetup

If you are unable to access WebSetup by entering the DNS name of the Fiery in Internet 
Explorer, perform the following steps:

1. Start WebSetup by entering the IP address of the Fiery in Internet Explorer.

The Accessing WebSetup window appears, displaying instructions for configuring 
Internet Explorer.

2. Follow the instructions displayed in the window. If the Java Custom Settings button is not 
visible, scroll to the Microsoft VM area of the Custom Level dialog box, and select Custom 
under Java Permissions.

3. Repeat the instructions, but select the Local Intranet zone, instead of Internet. Configure 
the Local Intranet options using the same settings that were used for the Internet zone.

Reboot Server 

Selecting Reboot Server from Command WorkStation may cause the Fiery to 
stop responding.

FTP Proxy Setup

To use the FTP Proxy service, you must first enable FTP Services.

Printing from Tray 5 (Bypass Tray) by default

To set a default for jobs to use the Bypass Tray, specify the tray at print time in the printer 
driver. There is no Setup option by which the administrator can set a default. 

Fiery WebSetup
Part Number: 45033611
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WINS Address

The WINS Address does not appear in WebSetup in DHCP mode when you configure 
Network Setup. Print a Configuration page to see the WINS address.

Printing Groups

Fiery WebSetup allows you only to enable or disable the use of Printing Groups. To define 
the actual groups, use Command WorkStation. 

Mac OS computers

If you are unable to start WebSpooler from a Mac OS computer using Internet Explorer, 
do the following:

1. Start Internet Explorer.

2. Choose Preferences from the Edit menu.

3. Under the Java section of the Preferences dialog box, clear “Restrict Access to 
Non-Java Files.”

You can also change settings for viewing and printing the Job Log.

4. Under the Receiving Files area, select File Helpers and click Add.

5. Configure settings as follows, without adding blank spaces:

• Description: Job Log

• Extension: .log

• MIME type: TEXT

• File type: TEXT

• File creator: TEXT

• For Encoding, select the Plain Text, Use For Incoming, and Use For Outgoing options. 
Leave the remaining options cleared.

• From the Download Destination menu, choose Download Folder.

• From the Handling menu, choose Save To File.

Similarity to Command WorkStation

Fiery WebSpooler and Command WorkStation are both powerful job management tools. 
Although they are similar in functionality, they have different interfaces. For example, the 
WebSpooler RIP queue is similar to the Command WorkStation Processing area.

DNS requirement

You must enable DNS on the Fiery before enabling the PrintMe™ features. Otherwise, the 
Fiery tries to connect to the PrintMe server every 10 seconds and is unsuccessful.

Installation

The installation software includes:

• PPD Installer—installs the PostScript Printer Description files (PPDs) necessary to print 
from Mac OS X.

• Language folders—contain copies of the files that are installed by the PPD Installer. 
It is not necessary to open these folders or install them on your computer; the 
appropriate files are installed by the PPD Installer.

Fiery WebSpooler

PrintMe

Mac OS X
Part Number: 45033611
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TO INSTALL PRINTER DESCRIPTION FILES

1. Make sure that Print Center is not currently running on your computer.

Print Center updates the list of available printers when it restarts. If a printer description file 
is added while Print Center is running, you cannot select the associated printer model until 
you restart Print Center.

2. Start the PPD Installer.

3. Follow the on-screen instructions to install the software.

4. When the software has been installed successfully, start Print Center and choose Add. 

5. Select AppleTalk or IP printing in the pop-up menu.

For AppleTalk, choose the AppleTalk Zone and then choose the name of the Fiery.

For IP Printing, enter the IP address or DNS name for the Fiery in the Printer’s Address 
field. Clear the “Use default queue on server” field. In the Queue Name field, enter print, 
hold, or direct (printing over TCP/IP to the direct connection is not supported for all Fiery 
models). Make sure that LPR printing and the specified queue are enabled on the Fiery. 
For more information about configuring TCP/IP printing, see the Configuration Guide.

6. For Printer Model, select the appropriate file for your language and Fiery model using one 
of the following methods:

If you are using an English-language system, select a copier/printer manufacturer name to 
display the list of all printer models for that manufacturer. Scroll through the list and select 
your printer model name. If you cannot find your printer model in the list for your 
manufacturer, browse to the EFI and Fiery folders in the Printers Model list.

If you are using a system with AppleTalk, choose Auto Select from the Printer Model list, 
and the system selects the correct file for your printer. If more than one file corresponds to 
your printer, a dialog box displays a list of all valid files. If that occurs, cancel Auto Select 
and select the correct file from the Printer Model list.

NOTE: If the PPD does not appear in the list of available PPDs, or it appears, but the PPD 
options are not in the correct language, navigate to the appropriate language folder and 
manually select the file. If you are not using an English-language system, do not select the 
file name displayed in Print Center (for Dutch, French, German, Italian, Portuguese, 
Spanish, or Swedish), because this is the English file; no file names are displayed in the 
Print Center on a Japanese-language system. 
Part Number: 45033611
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If you are using a non-English system, choose Other from the Printer Model list. The 
Choose a File dialog box appears. Browse to the appropriate file for your Fiery using 
the location in the following table:

NOTE: Do not use the Rootdrivename:System:Library:Printers:PPDs:Contents:Resources 
folder to select a file.

7. Click Choose.

8. Click Add.

For more information about adding printers, see your Mac OS X documentation.

Support for utilities

Mac OS X Native mode does not currently support any Fiery utilities. Mac OS X Native 
mode only supports the Adobe PostScript driver. 

Possible to select invalid print option combinations

If you select an invalid setting or combination of settings when printing a document, 
no error message appears. For example, you may be able to select duplex printing on 
transparency media. Invalid settings and combinations are ignored by the Fiery.

Installable Options feature must be configured with Print Center

Configure device-specific options (for example, enabling a Finisher or the optional Fiery 
Graphic Arts Package) before you use them. This ensures that printing information for 
documents is sent to the Fiery correctly. 

The Configure button in Print Center and the Configure command in the Printers menu 
are not available. To enable device-specific print features, use the Installable Options 
feature.

Language Location of files

Dutch Rootdrivename:Library:Printers:PPDs:Contents:Resources:nl.lpro

English Rootdrivename:Library:Printers:PPDs:Contents:Resources:en.lproj

French Rootdrivename:Library:Printers:PPDs:Contents:Resources:fr.lproj

German Rootdrivename:Library:Printers:PPDs:Contents:Resources:de.lproj

Italian Rootdrivename:Library:Printers:PPDs:Contents:Resources:it.lproj

Japanese Rootdrivename:Library:Printers:PPDs:Contents:Resources:ja.lproj

Portuguese Rootdrivename:Library:Printers:PPDs:Contents:Resources:pt.lproj

Spanish Rootdrivename:Library:Printers:PPDs:Contents:Resources:es.lproj

Swedish Rootdrivename:Library:Printers:PPDs:Contents:Resources:sv.lproj
Part Number: 45033611
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TO CONFIGURE INSTALLABLE OPTIONS

1. Start Print Center.

2. Select your printer in the Printer List.

3. Choose Show Info from the Printer menu.

4. Select Installable Options in the pop-up menu.

5. Select the appropriate options for your device. 

6. Click Apply Changes and close the Printer Info screen.

Numbering in the Print dialog box may not be as expected

The pop-up menu in the Print dialog box groups related print options. If more than five 
settings are included in a category, multiple menu commands with the same name appear in 
the pop-up menu. The menu commands are numbered, and the numbering does not restart 
for menu commands in a different category. For example, the menu commands could be 
named ColorWise 1, ColorWise 2, ColorWise 3, Destination, Finishing 5, and Finishing 6.

Print dialog box may not be redrawn correctly

When you move between panes in the Print dialog box—for example between the Printer 
Features and Copies & Pages panes—the screen may not update properly, and the same 
options may continue to appear. If this occurs, click Cancel and choose Print again.

Default paper size not dependent upon language setting

The default paper size is US Letter, regardless of the primary language setting you choose 
when you start Mac OS X. The default paper size is not set in the PPD, as in Mac OS 9, 
but in the Print Center Preferences. Once set, this preference is used for all applications. 
As a workaround, set the default paper size manually.

Default paper size may be used for generic printers

In Mac OS X, standard paper sizes have their own naming convention when used for a 
generic and Fiery printer. When printing to a Fiery and selecting the paper size in the 
Page Setup dialog box of an application, do not choose Any Printer from the “Format for” 
menu. Choose the desired Fiery printer from the menu, and then select the paper size. 
The paper size name may not be identical to one specified in the PPD. If you choose 
Any Printer, your job may print on the default paper size (A4 or Letter).

Custom Page Size not supported in Mac OS X

Custom Page Size printing is generally not supported in Mac OS X. When you choose 
Custom Page Size in the Page Setup dialog box, your job is printed on the default paper 
size (A4 or Letter). If the Custom Page Size is larger than A4 or Letter, the image is 
usually clipped.

Jobs sent via IP Printing may not print

Some Fiery servers do not process and print jobs sent via IP Printing. If you use the 
IP Printing feature to send print jobs to the Fiery from Mac OS X, see the following 
procedure. 
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TO SEND IP PRINTING JOBS TO THE FIERY FROM MAC OS X

1. Start the PPD Installer.

Follow the on-screen instructions to install the software.

2. When the software has been installed successfully, start Print Center and choose Add. 

3. Choose IP Printing.

In the Printer’s Address field, enter the IP address or DNS name for the Fiery.

In the Queue Name field, enter print, hold, or direct (printing over TCP/IP to the direct 
connection is not supported for all Fiery models). Make sure that LPR printing and the 
specified queue are enabled on the Fiery.

4. Clear the “Use default queue on server” option.

For more details about LPR printing from UNIX, see your Mac OS X documentation. 

Member Printing

Member Printing is not supported.

Support for printing features

Mac OS X Native mode supports the Adobe PostScript driver with the following 
limitations:

Tab naming—Tabs are named with the letter “F”, followed by a digit (for example, F1, F2). 
The Print Center does not allow horizontal scrolling of tabs. Any tab name longer than the 
limit (which, with tab names of this type, is 12 characters) is truncated at the beginning and 
end of the list in the Print Center dialog box.

Maximum number of print options per tab—The maximum number of print options per 
tab is imposed by the tab naming limitation in the previous section, as well as a Print 
Center feature that limits the number to five print options per tab, regardless of how many 
you specify. With Mac OS X version 1.5, the maximum number of tabs that can be 
displayed is 12 (a maximum of 60 print options).

User interface constraints—If your print job contains combinations of incompatible print 
option settings, the Fiery attempts to correct the settings, although unexpected results may 
occur in the printed output. Such combinations of incompatible print options can occur in 
PostScript jobs that you create or in jobs printed from applications that do not acknowledge 
the limitations in the PPD. In case of incompatibility, the Fiery attempts to change the tray 
selection to Tray 5 (Bypass Tray). In addition, the Fiery may also change the job to be 
single-sided, without stapling, and output to the Center Output Tray.

Installable options—Configuring the printer driver for options installed on the copier is 
not supported. Configure installable options with Print Center.

Custom Page Sizes—Custom page sizes are not supported.

When you start Mac OS X in English and install a printer, the operating system defaults to 
the available PPD list in the English folder (en.lproj), which was updated during the PPD 
installation. When starting in any other language, the operating system does not use this list 
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from the language-specific folder, but from the English folder. For European languages, the 
English PPD is used by default. With the Auto Select option, the English PPD is selected 
automatically.

ColorSync folder

When loading ICC profiles on Mac OS X, use the Mac OS 9 ColorSync folder on the 
User Software CD. The Mac OS X folder on the User Software CD does not contain the 
ColorSync folder with all the ICC profiles.

Selecting incompatible print option settings 

The Mac OS X printer driver does not warn you about selecting incompatible print option 
settings, including those for Media Type and Finisher.

Internet Explorer

When you print a page from Internet Explorer on Mac OS X Native mode, the page 
defaults to Letter SEF instead of Letter LEF.

PowerPoint

You may find that the Remove White PPT Background option does not function correctly 
from PowerPoint X. This is an issue with Office v. X, rather than with Mac OS X. 
PowerPoint X creates a different PostScript code when drawing white backgrounds than 
that created in previous versions of PowerPoint (for example, PowerPoint 2001). Fiery 
servers shipped prior to the release of Office v.X did not remove this PostScript properly. 
With servers shipped since the release of Office v. X, this should not present a problem.

Collate

Do not use the Collate option within an application; use only the Collate option in the 
printer driver. However, for CorelDRAW and Microsoft Internet Explorer versions 5 and 
5.5, use the Collate option in the printer driver in addition to the Collate option within the 
application.

Landscape duplex

When you print a landscape job as duplex, some applications, such as Adobe PageMaker 
and Adobe Acrobat 4, produce Top-Top output when you select Top-Bottom, and vice 
versa. For Acrobat 5 jobs, select the Auto Rotation check box for duplex printing.

Manual duplex

The manual duplex print option is available only from the printer driver. Also, you must 
select Tray 5 (Bypass Tray).

NOTE: You cannot set a Custom Page size to a manual duplex job.

After you print the first side of a manual duplex job, remove all paper from Tray 5 (Bypass 
Tray) and place the printed page face up on Tray 5. Disregard the message that is displayed 
on the copier and in Command WorkStation (“The paper type you currently have loaded 
in Tray 5 is different from the driver setting.”).

Applications
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QuarkXPress

Because of a limitation in QuarkXPress, you cannot print multiple pages on the same sheet 
of paper (Multiple-up, or N-up printing). 

Landscape orientation

Microsoft Word, Microsoft PowerPoint, and Acrobat jobs will not print in Landscape 
orientation using the PostScript or PCL drivers. You must select the orientation from the 
application’s Page Setup or Print dialog box.

N-up printing

With QuarkXPress, CorelDRAW, and Photoshop, you may not receive the correct number 
of N-up copies.

Adobe FrameMaker

FrameMaker jobs are not collated.

Adobe PageMaker 7

To adjust the layout of a job in PageMaker 7 for Windows, use the application part of the 
printer driver. For example, when you print a job, (File>Print), set the orientation of the 
job by using the setting in the lower-right corner.

Member Printing is not supported with PageMaker.

When you print separations using PageMaker, the output may be unexpected. You may 
receive an error message that says the job was pre-separated and to use color plates other 
than CMYK. 

Microsoft PowerPoint

When you select the number of copies in the Adobe PostScript driver, the driver will not 
update the number of copies in the application that you are running. To print the requested 
copies, enter the number of copies in the application’s Print dialog box and in the Adobe 
PostScript printer driver.

CorelDRAW

Some Multiple-up jobs from Mac OS computers are not printed and cause a PostScript 
error. The same is true for CorelDRAW 10 for Windows.

Adobe Acrobat Reader

Adobe Acrobat Reader 5.1 may not be able to print Landscape jobs on most page sizes 
correctly and images may be clipped. Use 8.5x11 LEF paper when printing Landscape jobs 
using Acrobat Reader 5.1, or use Adobe Acrobat 4.0.
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